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Overall Instructions

	Run queries using Query Viewer.

	Select Output to Excel 

	Save reports and queries in 8.9 Query directory for each institution

	Some 7.5 reports have no file extension (such as ".xls") - these can be opened with notepad.

	Others have an extension of ".aud" - these will also need to be opened with notepad.

	Also, the .spf files should be opened in your sqr viewer.  This occurs with the ACTUALS LEDGER TRIAL BALANCE (report)

	If you have any questions about the queries or reports in 7.5, please let Jason (Purchasing, AM & AR) or Ursula (AP & GL) know. 

	Run the following nVision reports, for 2007 and 2008:

· CASHFLOW= Cashflow 

· SNA= Statement of Net Assets 

· RECNA= Srecna 

· UNA= Note for UNA

· RA= Note for RA

· AUXSNA= Statement of Net Assets (AUX)

· AUXSREC= Srecna (AUX)

· NAT= Natural vs. Functional

· CAPASS= Capital Assets Disclosure.  

DO NOT run the AERSCHOP nVision report.

Store the nVision reports for each year in separate directories:

2007-7.5

2007-8.9

2008-7.5

2008-8.9

NOTE:  If you have a problem posting nVision reports, ( status of "Not Posted") can be redistributed by clicking Details->Re-send Content.



	For Continuous Audit reports, the key is: 

· borif01A= Continuous Audit Travel – verify that the same errors appear on both reports
· borif01B = Continuous Audit Perdiem  - same
· borif01C = Continuous Audit C (this will also produce 2 .AUD files) – verify the report totals are the same on both reports


Asset Management

BORQM002_AP_AM_ASSET_LOAD 

	7.5 Query Name:
	BORQM002_AP_AM_ASSET_LOAD

	8.9 Query Name: 
	BORQM002_AP_AM_ASSET_LOAD

	Navigation:
	Reporting Tools >  Query > Query Viewer

	Special Instructions:
	None

	Parameters (Values)
	No Prompts

	Expected Results:
	Should not return any rows 


BOR_CAP_ACT_DTL_BQ 

	7.5 Query Name:
	BOR_CAP_ACT_DTL_BQ

	8.9 Query Name: 
	BOR_CAP_ACT_DTL_BQ

	Navigation:
	Reporting Tools >  Query > Query Viewer

	Special Instructions:
	None

	Parameters (Values)
	Accounting Period = 12

Fiscal Year = 2007

	Expected Results:
	Should return one row for each chart field combination in Period 12 of 2007


BOR_CAPITAL_LEDGER_TTLS 

	7.5 Query Name:
	BOR_CAPITAL_LEDGER_TTLS

	8.9 Query Name: 
	BOR_CAPITAL_LEDGER_TTLS

	Navigation:
	Reporting Tools >  Query > Query Viewer

	Special Instructions:
	None

	Parameters (Values)
	Fiscal Year = 2007

	Expected Results:
	Should return one row for each Accounting Period, plus the adjustment (999, 998) period(s) in 2007


BOR_DEPR_AM_DIST_LN_BQ 

	7.5 Query Name:
	BOR_DEPR_AM_DIST_LN_BQ

	8.9 Query Name: 
	BOR_DEPR_AM_DIST_LN_BQ

	Navigation:
	Reporting Tools >  Query > Query Viewer

	Special Instructions:
	None

	Parameters (Values)
	Accounting Period = 12

Fiscal Year = 2007

	Expected Results:
	Should return one row for each asset with entries to the 890100 account in Period 12 of 2007


BOR_DEPR_AM_DET_BY_PERIOD_BQ 

	7.5 Query Name:
	BOR_DEPR_AM_DET_BY_PERIOD_BQ

	8.9 Query Name: 
	BOR_DEPR_AM_DET_BY_PERIOD_BQ

	Navigation:
	Reporting Tools >  Query > Query Viewer

	Special Instructions:
	None

	Parameters (Values)
	Accounting Period = 12

Fiscal Year = 2007

	Expected Results:
	Should return one row for each asset in the ENTERPRISE book with depreciation entries in Period 12 of 2007


BOR_SVP_AM_DTL 

	7.5 Query Name:
	BOR_SVP_AM_DTL

	8.9 Query Name: 
	BOR_SVP_AM_DTL

	Navigation:
	Reporting Tools >  Query > Query Viewer

	Special Instructions:
	None

	Parameters (Values)
	From Date = 07/01/06

Through Date = 06/30/07

	Expected Results:
	Returns one row for each active asset with CATEGORY = SVP


BOR_ASSET_LISTING_AUDITORS 

	7.5 Query Name:
	BOR_ASSET_LISTING_AUDITORS

	8.9 Query Name: 
	BOR_ASSET_LISTING_AUDITORS

	Navigation:
	Reporting Tools >  Query > Query Viewer

	Special Instructions:
	None

	Parameters (Values)
	Asset Book Name = ENTERPRISE

	Expected Results:
	Returns one row per asset in the ENTERPRISE book


BOR_AUD_AM_DETAIL 

	7.5 Query Name:
	BOR_AUD_AM_DETAIL

	8.9 Query Name: 
	BOR_AUD_AM_DETAIL

	Navigation:
	Reporting Tools >  Query > Query Viewer

	Special Instructions:
	NOTE:  This is an “Audit Query” – may have been altered by institutions after MODEL version distributed – may need to make additional updates criteria in 7.5 to match 8.9 model query.
DO NOT save your changes!



	Parameters (Values)
	From Account = 000000

To Account = 999999

Fiscal Year = 2007

Range From Accounting Period = 1

Range Through Accounting Period = 12

	Expected Results:
	Returns one row per asset / chart field combination for asset accounting entries journal generated to the CAPITAL ledger 


ASSET – AVAIL_SW (New Query)

	7.5 Query Name:
	8.9 Query only 

	8.9 Query Name: 
	Validate AVAIL_SW setting is not set to N in the PS_ASSET table:


SELECT A.AVAIL_SW, A.BUSINESS_UNIT, A.ASSET_ID, A.ASSET_TYPE, A.ASSET_SUBTYPE, A.PARENT_ID, A.COMPONENT_OF_ID, A.ASSET_ASSIGNED_TO, A.TAGGABLE_SW, A.TAG_NUMBER, A.DESCR, A.DESCRSHORT, A.ASSET_STATUS, A.FINANCIAL_ASSET_SW, A.REPLACE_SW, A.REPLACE_ASSET_ID, A.CONVERSION_ID, A.NEW_ASSET_SW, A.AVAIL_CONTACT, A.AVAIL_PHONE, A.ACQUISITION_CD, TO_CHAR(A.ACQUISITION_DT,'YYYY-MM-DD'), A.FINANCING_CD, A.REPLACEMENT_COST, TO_CHAR(A.REPLACE_COST_DT,'YYYY-MM-DD'), A.LEASE_ASSET_ID, A.PROFILE_ID, A.ASSET_CLASS, A.CAP_NUM, A.CAP_SEQUENCE, A.MFG_ID, A.MANUFACTURER, A.MODEL, A.PROD_VERSION, A.SERIAL_ID, TO_CHAR(A.PRODUCTION_DT,'YYYY-MM-DD'), A.PLANT, A.MANUFACTUR_CONTACT, A.BUSINESS_UNIT_JV, A.INDEX_NAME, A.INDEX_DETAIL_NAME, A.LAST_INDEX_VALUE, A.COMPOSITE_SW, A.COMPOSITE_ID, A.FERC_CD, A.GROUP_ASSET_FLAG, A.CURRENCY_CD, A.RD_PLANT_ASSET, TO_CHAR(A.RD_START_DT,'YYYY-MM-DD'), A.RD_USE_NBV, A.IP_ADDRESS, A.IP_ALIAS, A.COLLATERAL_ASSET, A.CLUSTERED_ASSET, A.LIFE, TO_CHAR(A.LAST_REVIEW_DT,'YYYY-MM-DD'), A.AM_AST_UD_CHAR1, A.AM_AST_UD_CHAR2, TO_CHAR(A.AM_AST_UD_DATE1,'YYYY-MM-DD'), A.AM_AST_UD_NUM1, A.AM_AST_UD_NUM2, A.LAST_CALC_RPL_COST, A.HAZARDOUS_SW, A.SS_STATUS, A.VIN, A.ASSET_RESOURCE_SW, A.ALLOW_OVERBOOK_SW, A.CHARGE_BACK_SW, A.SCHEDULABLE_SW, A.EPL_TMPL_ID, A.REPAIRABLE_FLG, A.REPAIR_STATUS, A.BUSINESS_UNIT_WO, A.SHOP_ID, A.UNOWNED_FLG, A.WO_LOCATION_FLG, A.OFFLINE_FLG, A.ASSET_CRITICALITY, A.AVAIL_FOR_USE, A.IT_UD_CHAR1, A.IT_UD_CHAR2, TO_CHAR(A.IT_UD_DATE1,'YYYY-MM-DD'), TO_CHAR(A.IN_SERVICE_DT,'YYYY-MM-DD'), A.REGION_CD, A.SKU, A.CRM_IPROD_ID, A.CRM_IPROD_SETID, A.CRM_IPROD_STATUS, A.CRM_DEPT_SETID 
  FROM PS_ASSET A 
  WHERE A.AVAIL_SW <> 'N' 



	Navigation:
	Reporting Tools >  Query > Query Manager

	Special Instructions:
	New Query!

Query the ASSET table and verify AVAIL_SW is set to Y. 
(There is a SQL script executed during the conversion to populate this value. This query validates the script has been run.)

	Parameters (Values)
	No Prompts

	Expected Results:
	All assets have AVAIL_SW set to ‘Y’


PROFILE_DET_TBL – Salvage Value (New Query)

	7.5 Query Name:
	8.9 Query Only

	8.9 Query Name: 
	Validate Salvage Value Settings in the PS_PROFILE_DET_TBL:

SELECT A.SETID, A.PROFILE_ID, A.BOOK, TO_CHAR(A.EFFDT,'YYYY-MM-DD'), A.CATEGORY, A.DEPR_STATUS, A.REGULATION, A.RECOVERY_LIFE, A.RECOVERY_SUBTYPE, A.CONVENTION, A.RETIRE_CONVENTION, A.METHOD, A.CALCULATION_TYPE, A.DEPR_PERCENT, A.DB_PERCENT, A.DEPR_SCHED_CD, A.DEPR_LIMIT_CD, A.LIFE, A.TAX_CLASS_AM, A.PROPERTY_CD, A.PROPERTY_TYPE, A.SALVAGE_VALUE, A.SALVAGE_PCT, TO_CHAR(A.LIFE_END_DT,'YYYY-MM-DD'), A.DEPR_LOW_LIMIT, A.COST_BASIS_LIMIT, A.DEPR_AVG_OPTION, A.UOP_ID, A.GROUP_BUS_UNIT, A.GROUP_ASSET_ID, A.CURRENCY_CD, A.INCLUDE_CAP_GAINS, A.UD_METHOD_ID, A.PERIOD_DEPR_SW, A.DEPR_PASS_LIFE_SW, A.LISTED_PROP, A.LISTED_PROP_TYPE, A.BUS_USE_PERCENT, A.SEC_291, A.DEPR_LIMIT_PCT, A.MULTI_SHIFT_CODE, A.MULTI_SHIFT_NBR, A.SPECIAL_TERMS, A.ACCELERATED_TERMS, A.INITIAL_TERMS, A.INCREASE_RATE, A.ACCOUNTING_MTHD, A.SPECIAL_DEPR_SW, A.LOW_VALUE_SW, A.BUSINESS_TAX_FLG, A.DEROGATORY_SW, A.FUTURE_DEPR_YEARS, A.ROUND_RULE_AM, A.ROUND_TYPE, A.ROUND_PRECISION, A.ROUND_FACTOR, A.TRUNCATE_FLAG, A.DEPR_BONUS_SW, A.DEPR_BONUS_PCT, A.AM_BK_UD_CHAR1, A.AM_BK_UD_CHAR2, TO_CHAR(A.AM_BK_UD_DATE1,'YYYY-MM-DD'), A.AM_BK_UD_NUM1, A.AM_BK_UD_NUM2, A.IMPAIR_FLG 
  FROM PS_PROFILE_DET_TBL A 
  WHERE A.EFFDT = 
        (SELECT MAX(A_ED.EFFDT) FROM PS_PROFILE_DET_TBL A_ED 
        WHERE A.SETID = A_ED.SETID 
          AND A.PROFILE_ID = A_ED.PROFILE_ID 
          AND A.BOOK = A_ED.BOOK 
          AND A_ED.EFFDT <= SYSDATE) 
     AND A.SALVAGE_PCT > .0


	Navigation:
	Reporting Tools >  Query > Query Manager

	Special Instructions:
	Note: The salvage percent used in the query criteria is .0, not 0

	Parameters (Values)
	Salvage Percent > .0

	Expected Results:
	Should give you 46 rows

Tell someone if you do not get the same row counts


Accounts Payable

BOR_BR_ISSUE 
	7.5 Query Name:
	BOR_BR_ISSUE

	8.9 Query Name: 
	BOR_BR_AP_ISSUE

	Navigation:
	Reporting Tools >  Query > Query Viewer 

	Special Instructions:
	See Bank Table below to determine which Bank Code and Account to use in the query parameters – institution specific.

	Parameters (Values)
	Beginning Date = 07/01/06

Ending Date = 06/30/07

Bank Code = <institution specific>

Bank Account = <institution specific>
Institution

Bank Code

Bank Account Key

Bank Account Number

F210

SECBK

SECB

65003220

F240

FCBNK

OPER

0002128080

F270

MOPER

MOPR

2000126933224

F280

MBOPR

OPER

2079900513710

F280

MBOPR

OPR4

2000126744138

F300

MBOPR

OPER

2459345

F330

MBOPR

OPER

310002202

F360

MBOPR

OPER

310002202

F390

MBOPR

OPER

5145667498

F400

MBOPR

OPER

2000028328377

F420

MBOP3

OPER

2000032278316

F430

MB2OP

OPR2

2000027644939

F450

BBT

OPER

0005148600661

F480

WACH

WACH

2000016951523

F500

MBOPR

OPER

000603759446

F510

MBOPR

OPER

000603759446

F540

MBOPR

OPER

01-55-549

F570

MBOPR

OPER

52084

F610

BBTOP

BBTO

5148108007

F620

MBOPR

OPER

147002424

F630

CBOPR

CBOP

178083

F690

OPR

OPR

2000183052258

F700

MBOPR

OPER

029785

F710

WACH1

WACH

2000126544370

F720

MBOPR

OPER

0140068101

F730

MBOPR

OPER

2060204414

Institution

Bank Code

Bank Account Key

Bank Account Number

F750

OPER2

OPR2

0005148337111

F760

MBOPR

OPER

1016

F810

MBOPR

OPER

5140358217

F840

MBOPR

OPER

0002006

F870

MBOPR

OPER

1000020132303

F890

MBOPR

OPER

9800279979

F930

MBOPR

OPER

2000035482659

F980

MBOPR

OPER

2000126745894

Institution

Bank Code

Bank Account Key

Bank Account Number

F210

SECBK

SECB

65003220

F240

FCBNK

OPER

0002128080

F270

MOPER

MOPR

2000126933224

F280

MBOPR

OPER

2079900513710

F280

MBOPR

OPR4

2000126744138

F300

MBOPR

OPER

2459345

F330

MBOPR

OPER

310002202

F360

MBOPR

OPER

310002202

F390

MBOPR

OPER

5145667498

F400

MBOPR

OPER

2000028328377

F420

MBOP3

OPER

2000032278316

F430

MB2OP

OPR2

2000027644939

F450

BBT

OPER

0005148600661

F480

WACH

WACH

2000016951523

F500

MBOPR

OPER

000603759446

F510

MBOPR

OPER

000603759446

F540

MBOPR

OPER

01-55-549

F570

MBOPR

OPER

52084

F610

BBTOP

BBTO

5148108007

F620

MBOPR

OPER

147002424

F630

CBOPR

CBOP

178083

F690

OPR

OPR

2000183052258

F700

MBOPR

OPER

029785

F710

WACH1

WACH

2000126544370

F720

MBOPR

OPER

0140068101

F730

MBOPR

OPER

2060204414

Institution

Bank Code

Bank Account Key

Bank Account Number

F750

OPER2

OPR2

0005148337111

F760

MBOPR

OPER

1016

F810

MBOPR

OPER

5140358217

F840

MBOPR

OPER

0002006

F870

MBOPR

OPER

1000020132303

F890

MBOPR

OPER

9800279979

F930

MBOPR

OPER

2000035482659

F980

MBOPR

OPER

2000126745894



	Expected Results:
	Query should return a listing of all checks that have not been reconciled and/or have been voided (canceled) in the time frame used in the query parameters.


BOR_BR_CANCEL_CUR 
	7.5 Query Name:
	BOR_BR_CANCEL_CUR

	8.9 Query Name: 
	BOR_BR_AP_CANCEL_CUR

	Navigation:
	Reporting Tools >  Query > Query Viewer 

	Special Instructions:
	See Bank Table below to determine which Bank Code and Account to use in the query parameters – institution specific.

	Parameters (Values)
	Beginning Date = 07/01/06

Ending Date = 06/30/07

Bank Code = <institution specific>

Bank Account = <institution specific>
Institution

Bank Code

Bank Account Key

Bank Account Number

F210

SECBK

SECB

65003220

F240

FCBNK

OPER

0002128080

F270

MOPER

MOPR

2000126933224

F280

MBOPR

OPER

2079900513710

F280

MBOPR

OPR4

2000126744138

F300

MBOPR

OPER

2459345

F330

MBOPR

OPER

310002202

F360

MBOPR

OPER

310002202

F390

MBOPR

OPER

5145667498

F400

MBOPR

OPER

2000028328377

F420

MBOP3

OPER

2000032278316

F430

MB2OP

OPR2

2000027644939

F450

BBT

OPER

0005148600661

F480

WACH

WACH

2000016951523

F500

MBOPR

OPER

000603759446

F510

MBOPR

OPER

000603759446

F540

MBOPR

OPER

01-55-549

F570

MBOPR

OPER

52084

F610

BBTOP

BBTO

5148108007

F620

MBOPR

OPER

147002424

F630

CBOPR

CBOP

178083

F690

OPR

OPR

2000183052258

F700

MBOPR

OPER

029785

F710

WACH1

WACH

2000126544370

F720

MBOPR

OPER

0140068101

F730

MBOPR

OPER

2060204414

Institution

Bank Code

Bank Account Key

Bank Account Number

F750

OPER2

OPR2

0005148337111

F760

MBOPR

OPER

1016

F810

MBOPR

OPER

5140358217

F840

MBOPR

OPER

0002006

F870

MBOPR

OPER

1000020132303

F890

MBOPR

OPER

9800279979

F930

MBOPR

OPER

2000035482659

F980

MBOPR

OPER

2000126745894



	Expected Results:
	Query will return a listing of all checks that were voided (canceled) in the time frame used in the query parameters and posted in the current accounting period.


BOR_BR_CANCEL_PRIOR 
	7.5 Query Name:
	BOR_BR_CANCEL_PRIOR

	8.9 Query Name: 
	BOR_BR_AP_CANCEL_PRIOR

	Navigation:
	Reporting Tools >  Query > Query Viewer 

	Special Instructions:
	See Bank Table below to determine which Bank Code and Account to use in the query parameters – institution specific.

	Parameters (Values)
	Beginning Date = 07/01/06

Ending Date = 06/30/07

Bank Code = <institution specific operating account>

Bank Account = <institution specific operating account>
Institution

Bank Code

Bank Account Key

Bank Account Number

F210

SECBK

SECB

65003220

F240

FCBNK

OPER

0002128080

F270

MOPER

MOPR

2000126933224

F280

MBOPR

OPER

2079900513710

F280

MBOPR

OPR4

2000126744138

F300

MBOPR

OPER

2459345

F330

MBOPR

OPER

310002202

F360

MBOPR

OPER

310002202

F390

MBOPR

OPER

5145667498

F400

MBOPR

OPER

2000028328377

F420

MBOP3

OPER

2000032278316

F430

MB2OP

OPR2

2000027644939

F450

BBT

OPER

0005148600661

F480

WACH

WACH

2000016951523

F500

MBOPR

OPER

000603759446

F510

MBOPR

OPER

000603759446

F540

MBOPR

OPER

01-55-549

F570

MBOPR

OPER

52084

F610

BBTOP

BBTO

5148108007

F620

MBOPR

OPER

147002424

F630

CBOPR

CBOP

178083

F690

OPR

OPR

2000183052258

F700

MBOPR

OPER

029785

F710

WACH1

WACH

2000126544370

F720

MBOPR

OPER

0140068101

F730

MBOPR

OPER

2060204414

Institution

Bank Code

Bank Account Key

Bank Account Number

F750

OPER2

OPR2

0005148337111

F760

MBOPR

OPER

1016

F810

MBOPR

OPER

5140358217

F840

MBOPR

OPER

0002006

F870

MBOPR

OPER

1000020132303

F890

MBOPR

OPER

9800279979

F930

MBOPR

OPER

2000035482659

F980

MBOPR

OPER

2000126745894



	Expected Results:
	Query will return a listing of all checks that were voided (canceled) in the time frame used in the query parameters and posted in the previous accounting period.


BOR_BR_OSCK 
	7.5 Query Name:
	BOR_BR_OSCK

	8.9 Query Name: 
	BOR_BR_AP_OSCK

	Navigation:
	Reporting Tools >  Query > Query Viewer 

	Special Instructions:
	See Bank Table below to determine which Bank Code and Account to use in the query parameters – institution specific.

	Parameters (Values)
	As of Date = 06/30/07

Bank Code = <institution specific>

Bank Account = <institution specific>

Institution

Bank Code

Bank Account Key

Bank Account Number

F210

SECBK

SECB

65003220

F240

FCBNK

OPER

0002128080

F270

MOPER

MOPR

2000126933224

F280

MBOPR

OPER

2079900513710

F280

MBOPR

OPR4

2000126744138

F300

MBOPR

OPER

2459345

F330

MBOPR

OPER

310002202

F360

MBOPR

OPER

310002202

F390

MBOPR

OPER

5145667498

F400

MBOPR

OPER

2000028328377

F420

MBOP3

OPER

2000032278316

F430

MB2OP

OPR2

2000027644939

F450

BBT

OPER

0005148600661

F480

WACH

WACH

2000016951523

F500

MBOPR

OPER

000603759446

F510

MBOPR

OPER

000603759446

F540

MBOPR

OPER

01-55-549

F570

MBOPR

OPER

52084

F610

BBTOP

BBTO

5148108007

F620

MBOPR

OPER

147002424

F630

CBOPR

CBOP

178083

F690

OPR

OPR

2000183052258

F700

MBOPR

OPER

029785

F710

WACH1

WACH

2000126544370

F720

MBOPR

OPER

0140068101

F730

MBOPR

OPER

2060204414

Institution

Bank Code

Bank Account Key

Bank Account Number

F750

OPER2

OPR2

0005148337111

F760

MBOPR

OPER

1016

F810

MBOPR

OPER

5140358217

F840

MBOPR

OPER

0002006

F870

MBOPR

OPER

1000020132303

F890

MBOPR

OPER

9800279979

F930

MBOPR

OPER

2000035482659

F980

MBOPR

OPER

2000126745894



	Expected Results:
	Query will return a listing of all checks that were paid in the time frame used in the query parameters but have not “cleared the bank.”


BOR1P001_UNPOSTED_VCHR 
	7.5 Query Name:
	BORQP001_UNPOSTED_VCHR

	8.9 Query Name: 
	BOR_AP_UNPOSTED_VCHR

	Navigation:
	Reporting Tools >  Query > Query Viewer 

	Special Instructions:
	None


	Parameters (Values)
	No Prompts 

	Expected Results:
	Query will return a listing of open vouchers that are unposted in AP.



BORQP002_UNPOSTED_PYMNTS 
	7.5 Query Name:
	BORQP002_UNPOSTED_PYMNTS

	8.9 Query Name: 
	BOR_AP_UNPOSTED_PYMNTS

	Navigation:
	Reporting Tools > Query > Query Manager 

	Special Instructions:
	Update the 8.9 Query before running it:

· Add the following criteria.

OR A.CANCEL_ACTION IN ('C','H','R') (on the Payment table)
DO NOT save your changes!



	Parameters (Values)
	No Prompts 

	Additional Instructions:
	Query will return a listing of payments that are unposted in AP.


BOR_AP_DUE 
	7.5 Query Name:
	BOR_AP_DUE

	8.9 Query Name: 
	BOR_AP_DUE

	Navigation:
	Reporting Tools >  Query > Query Viewer 

	Special Instructions:
	Execute the query three times, once for each of the following Pay Methods (CHK, EFT and ACH)

	Parameters (Values)
	First Run: 

· Pay Thru Date = 06/30/07 

· Method = CHK

Second Run:

· Pay Thru Date = 06/30/07

· Method = EFT (if applicable)
Third Run:

· Pay Thru Date = 06/30/07

· Method = ACH (if applicable)


	Expected Results:
	Query will return a listing of unpaid vouchers.


BOR_BR_GLCAP 
	7.5 Query Name:
	BOR_BR_GLCAP

	8.9 Query Name: 
	BOR_BR_GLCAP

	Navigation:
	Reporting Tools >  Query > Query Viewer 

	Special Instructions:
	None

	Parameters (Values)
	Accounting Period = 12

Fiscal Year = 2007

	Expected Results:
	Query will return a listing of transactions charged to the cash accounts (118100, 111000 and 118200) during the time frame used in the query parameters.


BOR_AUD_AP_OUTSTANDING 
	7.5 Query Name:
	BOR_AUD_AP_OUTSTANDING

	8.9 Query Name: 
	BOR_AUD_AP_OUTSTANDING

	Navigation:
	Reporting Tools >  Query > Query Viewer 

	Special Instructions:
	None

	Parameters (Values)
	From Account = 211000

To Account = 211800

Fiscal year = 2007

Fund = 10000

	Expected Results:
	Query will return a listing of vouchers where the amounts charged to liability accounts do not net to zero.


BOR_OPEN_LIAB_AP 
	7.5 Query Name:
	BOR_OPEN_LIAB_AP

	8.9 Query Name: 
	BOR_AP_OPEN_LIAB 

	Navigation:
	Reporting Tools >  Query > Query Viewer 

	Special Instructions:
	None

	Parameters (Values)
	As of Fiscal Year = 2007

As of Accounting Period = 12

	Expected Results:
	Query will return a list of journal generated AP transactions that do not net to zero.


Accounts Receivable

BOR_AR_CR_NOTINGL 
	7.5 Query Name:
	BOR_AR_CR_NOTINGL

	8.9 Query Name: 
	BOR_AR_CR_NOTINGL

	Navigation:
	Reporting Tools >  Query > Query Viewer

	Special Instructions:
	Run this query for USO and Skidaway only

	Parameters (Values)
	None

	Expected Results:
	Query will return a listing of AR transactions not journal generated


BOR_AR_DJ_NOTINGL 

	7.5 Query Name:
	BOR_AR_DJ_NOTINGL

	8.9 Query Name: 
	BOR_AR_DJ_NOTINGL

	Navigation:
	Reporting Tools >  Query > Query Viewer

	Special Instructions:
	Run this query for USO and Skidaway only

	Parameters (Values)
	None

	Expected Results:
	Query will return a listing of direct journals not journal generated


BOR_AR_UNPOSTED 
	7.5 Query Name:
	BOR_AR_UNPOSTED

	8.9 Query Name: 
	BOR_AR_UNPOSTED

	Navigation:
	Reporting Tools >  Query > Query Viewer

	Special Instructions:
	Run this query for USO and Skidaway only

	Parameters (Values)
	None

	Expected Results:
	Query will return a listing of unposted deposits and deposits that have not been “fully applied”


General Ledger / Commitment Control
BOR_BR_GLC_BNR 

	7.5 Query Name:
	BOR_BR_GLC_BNR

	8.9 Query Name: 
	BOR_BR_GLC_BNR

	Navigation:
	Reporting Tools >  Query > Query Viewer 

	Special Instructions:
	None

	Parameters (Values)
	Accounting Period = 12

Fiscal Year = 2007

	Expected Results:
	Query will return a listing of Banner deposits posted to cash accounts.


BOR_BR_GLC_FUNDBAL
	7.5 Query Name:
	BOR_BR_GLC_FUNDBAL

	8.9 Query Name: 
	BOR_BR_GLC_FUNDBAL

	Navigation:
	Reporting Tools >  Query > Query Viewer 

	Special Instructions:
	None

	Parameters (Values)
	Accounting Period = 12

Fiscal Year = 2007

	Expected Results:
	Query will return a listing of “fund balancing journals” charged to the cash accounts


BOR_JE_NOTINGL 
	7.5 Query Name:
	BOR_JE_NOTINGL

	8.9 Query Name: 
	BOR_JE_NOTINGL

	Navigation:
	Reporting Tools >  Query > Query Manager

	Special Instructions:
	Update the 8.9 Query before running it:
· Remove the following criteria:

AND KK_AMOUNT_TYPE IN ('1','7') 

AND LEDGER_GROUP IN ('ACTUALS', 'CAPITAL', 'GAAP') 

· Add the following criteria:

AND SOURCE <> ‘UPG’

DO NOT save your changes!



	Parameters (Values)
	No Prompts

	Expected Results:
	Query will return a listing of incomplete journals (“No Status-Needs to be Edited”, “Journal Edits Complete”, “Journal has Errors”, etc.)


BOR_JE_NOTINGL_CASH 
	7.5 Query Name:
	BOR_JE_NOTINGL_CASH

	8.9 Query Name: 
	BOR_JE_NOTINGL_CASH

	Navigation:
	Reporting Tools >  Query > Query Manager 

	Special Instructions:
	Update the 8.9 Query before running it:
· Remove the following criteria:

AND KK_AMOUNT_TYPE IN ('1','7') 

AND LEDGER_GROUP IN ('ACTUALS', 'CAPITAL', 'GAAP') 

· Add the following criteria:

AND SOURCE <> ‘UPG’

· Remove the aggregate function for MONETARY_AMOUNT field – should not be summed (Fields > Edit Field Properties … Aggregate (radio button) = None)
DO NOT save your changes!



	Parameters (Values)
	No Prompts

	Expected Results:
	Query will return a listing of incomplete journals related to cash accounts (“No Status-Needs to be Edited”, “Journal Edits Complete”, “Journal has Errors”, etc.)


BOR_JE_PENDING 
	7.5 Query Name:
	BOR_JE_PENDING

	8.9 Query Name: 
	BOR_JE_PENDING

	Navigation:
	Reporting Tools >  Query > Query Manager 

	Special Instructions:
	Update the 7.5 query before running it:

· Update criteria for the Selection related to DIST_LN to add X to the GL_DISTRIB_STATUS criteria … 

GL_DISTRIB_STATUS in [‘D’,’I’, ‘X’] 

· Add criteria to the Selection related to PO_LINE_ACCTG to remove PO transactions for the results set (archived in 8.9, therefore should be excluded from 7.5 results set) … 

AND BUSINESS_UNIT = ZZZZZ

DO NOT save your changes!
NOTE:  Selection for Journal Header and Journal Line includes criteria related to BCM_HDR_STATUS and JRNL_HDR_STATUS – cannot remove from query, but may generate reconciliation differences (see below for more discussion).


	Parameters (Values)
	Through Date = [Today’s Date] (7.5)

Through Date = 01/01/1901 (8.9)
Query updated in 8.9 to use “ greater than or equal to”  …  must run 7.5 query using [Today’s Date] as the Through Date, based on criteria of “less than or equal to”

	Expected Results:
	Query will return a listing of journals that have not been posted (do not have a status of ‘P’, ‘U’, or ‘Z’).
Differences between 7.5 and 8.9 may be caused by:

· Using the wrong Through Date

· Some journals in 8.9 relate to budget adjustment journals created during conversion – need to exclude them from 8.9 query: 

· Add the following criteria to exclude budget adjustment journals from the query results set:

· SOURCE <> UPG
· BCM_HDR_STATUS <> V or JRNL_HDR_ STATUS = P … in some instances, the 7.5 query will return legacy transactions that have a BCM_HDR_STATUS other than V (valid) and JRNL_HDR_STATUS = P (posted) (for example, when status flags were manually updated with a DBI)
· Ledger criteria is different – exclude any rows not related to the ACTUALS ledger  … should exclude CAPITAL and GAAP ledger in 8.9, since these ledgers are not budget checked in 7.5
· Need to address issues associated with BNNR rows, too – still investigating.


SELECT E.BUDGET_PERIOD, TO_CHAR(E.ACCOUNTING_DT,'YYYY-MM-DD'), 'ACTUALS' , 'AR' , 'ITEM#' ||  E.ITEM || ' ' ||  E.APPL_JRNL_ID || ' ' ||  E.SYSTEM_DEFINED, ' ', E.ACCOUNT, E.FUND_CODE, E.DEPTID, E.PROGRAM_CODE, E.CLASS_FLD, E.PROJECT_ID, E.MONETARY_AMOUNT

	  FROM PS_ITEM_DST E

  WHERE E.ACCOUNTING_DT <= TO_DATE(:4,'YYYY-MM-DD')

     AND E.GL_DISTRIB_STATUS NOT IN ('D','I')

UNION

SELECT F.BUDGET_PERIOD, TO_CHAR(F.ACCOUNTING_DT,'YYYY-MM-DD'), 'ACTUALS' , 'AR' , 'DEP#' ||  F.DEPOSIT_ID || '  ' ||  F.PAYMENT_SEQ_NUM || '  ' ||  F.DST_SEQ_NUM || ' ' ||  F.APPL_JRNL_ID || ' ' ||  F.SYSTEM_DEFINED , ' ' , F.ACCOUNT, F.FUND_CODE, F.DEPTID, F.PROGRAM_CODE, F.CLASS_FLD, F.PROJECT_ID, F.MONETARY_AMOUNT

  FROM PS_PAY_MISC_DST F

  WHERE F.GL_DISTRIB_STATUS NOT IN ('I','D')

     AND F.ACCOUNTING_DT <= TO_DATE(:5,'YYYY-MM-DD')

UNION

SELECT G.BUDGET_PERIOD, TO_CHAR(G.ACCOUNTING_DT,'YYYY-MM-DD'), G.LEDGER, 'AM' , 'ASSET#' ||  G.ASSET_ID || '  ' ||  G.APPL_JRNL_ID || ' ' ||  G.DISTRIBUTION_TYPE || ' ' ||  G.TRANS_TYPE || ' ' ||   G.CATEGORY , ' ' , G.ACCOUNT, G.FUND_CODE, G.DEPTID, G.PROGRAM_CODE, G.CLASS_FLD, G.PROJECT_ID, G.AMOUNT

  FROM PS_DIST_LN G

  WHERE G.GL_DISTRIB_STATUS NOT IN ('D','X','I')

     AND G.ACCOUNTING_DT <= TO_DATE(:6,'YYYY-MM-DD')

UNION

SELECT H.BUDGET_PERIOD, TO_CHAR(H.ACCOUNTING_DT,'YYYY-MM-DD'), H.LEDGER, 'BNR', COUNT( H.TRANSACTION_ID) || ' TRANSACTIONS EXIST FOR THIS ACCTG DATE', ' ', ' ', ' ', ' ', ' ', ' ', ' ', 0

  FROM PS_JGEN_BNR_BOR H

  WHERE H.GL_DISTRIB_STATUS NOT IN ('D','I')

     AND H.ACCOUNTING_DT <= TO_DATE(:7,'YYYY-MM-DD')

  GROUP BY  H.BUDGET_PERIOD,  TO_CHAR(H.ACCOUNTING_DT,'YYYY-MM-DD'),  H.LEDGER,  'BNR',  ' ',  ' ',  ' ',  ' ',  ' ',  ' ',  ' ',  0

  ORDER BY 1, 2, 3, 4, 5
	

	8.9 SQL
	SELECT A.BUDGET_REF, TO_CHAR(A.JOURNAL_DATE,'YYYY-MM-DD'), A.LEDGER, A.DIST_TYPE, A.JRNL_DESCR, A.KK_AMOUNT_TYPE, A.ACCOUNT, A.FUND_CODE, A.DEPTID, A.PROGRAM_CODE, A.CLASS_FLD, A.PROJECT_ID, A.MONETARY_AMOUNT 
  FROM PS_JE_STATVW_BOR A 
  WHERE A.JOURNAL_DATE >= TO_DATE(:2,'YYYY-MM-DD') 
  ORDER BY 1, 2, 3, 4, 5



BOR_AUD_TRIAL_BALANCE 
	7.5 Query Name:
	BOR_AUD_TRIAL_BALANCE

	8.9 Query Name: 
	BOR_AUD_TRIAL_BALANCE

	Navigation:
	Reporting Tools >  Query > Query Manager

	Special Instructions:
	Update the 7.5 query before running it:

· Add  Fund Code as a prompt
· Remove Having Criteria Tab (View > Having) regarding pre-encumbrance and encumbrance amounts 
DO NOT save your changes!

NOTE:  This is an “Audit Query” – may have been altered by institutions after MODEL version distributed – may need to make additional updates criteria in 7.5 to match 8.9 model query.

	Parameters (Values)
	Ledger = ACTUALS

Fiscal Year = 2007

Range From Accounting Period = 1

Range To Accounting Period = 12

Fund = 10000

	Expected Results:
	Query will return a listing of transactions summarized by chart field string that do not sum to zero.


BOR_AUD_TRIAL_BALANCE_BYACCT 
	7.5 Query Name:
	BOR_AUD_TRIAL_BALANCE_BYACCT

	8.9 Query Name: 
	BOR_AUD_TRIAL_BALANCE_BYACCT

	Navigation:
	Reporting Tools >  Query > Query Viewer 

	Special Instructions:
	None

	Parameters (Values)
	Ledger = ACTUALS

Fiscal Year = 2007

Range From Accounting Period = 1

Range To Accounting Period = 12

	Expected Results:
	Query will return a listing of transactions summarized by fund and account that do not net to zero.


BOR_AUD_TRIAL_BAL_PROJ_DESCR 

	7.5 Query Name:
	BOR_AUD_TRIAL_BAL_PROJ_DESCR

	8.9 Query Name: 
	BOR_AUD_TRIAL_BAL_PROJ_DESCR

	Navigation:
	Reporting Tools >  Query > Query Manager 

	Special Instructions:
	Update the 7.5 query before running it:
· Remove all “Having Criteria” (View > Having Criteria). 
DO NOT save your changes!
NOTE:  This query is based on the ledger tables in 7.5, on the Commitment Control tables in 8.9. 

To account for this difference, the account range must be limited to those accounts that are “subject to” Commitment Control (500000-999999).



	Parameters (Values)
	Fiscal Year = 2007

Range From Accounting Period = 1

Range To Accounting Period = 12

From Account = 500000
To Account = 999999

Fund = 20000

	Expected Results:
	Query will return a listing of transactions summarized by project, account and budget reference.


LEDGER / LEDGER_EG Table (New Query)
	7.5 Table name:
	LEDGER

	8.9 Table name: 
	UAT_LEDGER_EG (TABLE) (new Query to be created and saved)

	Navigation:
	Reporting Tools >  Query > Query Manager 

	Special Instructions:
	Create a new query to validate the row counts on business unit and sum of posted total amount. 
7.5 – LEDGER:
SELECT COUNT(*), SUM(A.POSTED_TOTAL_AMT) 
FROM PS_LEDGER A
8.9 – LEDGER_EG:

SELECT COUNT(*), SUM( A.POSTED_TOTAL_AMT)
  FROM PS_LEDGER_EG A


	Parameters (Values)
	No Prompts

	Expected Results:
	Okay for amounts not to be zero—the plant allocation throws it out of balance.


LEDGER_BUDG / LEDGER_KK_VW4_BOR Table (New Query)
	7.5 Query Name:
	LEDGER_BUDG (TABLE)

	8.9 Query Name: 
	UAT_LEDGER_KK_VW4_BOR  (TABLE) (new Query to be created and saved)

	Navigation:
	Reporting Tools >  Query > Query Viewer 

	Special Instructions:
	Create a new query to verify the row counts, based on business unit field, and the sum of posted, encumbered and pre-encumbered amounts. 

7.5 – LEDGER_BUDG:
SELECT COUNT(*), SUM(A. POSTED_TOTAL_AMT) 
FROM PS_LEDGER_BUDG A
8.9 – LEDG_KK_VW4_BOR:
SELECT COUNT(*), A. LEDGER, 

SUM( A.POSTED_TOTAL_AMT)

  FROM PS_LEDG_KK_VW_BOR A

GROUP BY A.LEDGER


	Parameters (Values)
	No Prompts

	Expected Results:
	Okay for amounts not to be zero—the plant allocation throws it out of balance.


PROJECT_HEADER / PROJECT_HDR_BOR Table (New Query)
	7.5 Query Name:
	PROJECT_HEADER (TABLE)

	8.9 Query Name: 
	PROJECT_HDR_BOR (TABLE) 

	Special Instructions:
	Create a new query to verify the row count in both tables. 
7.5 – PROJECT_HEADER:

SELECT COUNT(A.PROJECT_ID)  
FROM PS_PROJECT_HEADER A

8.9 – PROJECT_HDR_BOR:
SELECT COUNT(A.PROJECT_ID)

FROM PS_PROJECT_HDR_BOR A


	Parameters (Values)
	None

	Expected Results:
	Query will return a single row, displaying the number of rows in the table.


LEDGER TRIAL BALANCE BY FISCAL YEAR (GLS7012) 

	7.5 Report Name:
	LEDGER TRIAL BALANCE BY FISCAL YEAR (GLS7012)

	8.9 Report Name: 
	LEDGER TRIAL BALANCE BY FISCAL YEAR (GLS7012)

	Navigation:
	7.5 – Go, Process Financial Information, Process Journals, Report, Trial Balance

8.9 – General Ledger, General Reports, Trial Balance

	Special Instructions:
	Must create a new Run Control (see instructions below) and run the report 3 times (once for the ACTUALS, CAPITAL and GAAP ledgers).
After running the Trial Balance Reports:
· Go to Report Manager > List Tab and validate that the reports are displayed in the listing.  

· Go to the Administration Tab and the open reports.

	Parameters (Values)
	7.5 Instructions:

Business Unit: <Institution Specific>

Ledger = <ACTUALS, CAPITAL, GAAP> 
Fiscal Year = 2007

Accounting Period = 12 

DO NOT check any of the “include …” checkboxes.

Run the report on the client and output the report to 
c:\temp\ -ziv

8.9 Instructions:

Create a new run control with the following parameters:
· First Run Unit = <Institution Specific>

· Ledger = <ACTUALS, CAPITAL, GAAP>
· Fiscal Year = 2007

· Period = 12
· Currency Option = Base

· Currency = [Blank]

· Adjustment Period = [Blank]

Push Refresh button at right above Chart Field Selection

· Account Sequence = 1

· Enable ’Include CF’ checkbox

· Enable ‘Descr’ checkbox
Save the run control.
Then push the Run button at top right to initiate the process.

	Expected Results:
	Query will return a listing of balances summarized to the chart field string and fiscal year. Debits should equal Credits.
When reconciling the reports, may find zeroes in different places – Reserve for Encumbrances, and Reserve for Pre-Encumbrances, for example.

In some instances, the 7.5 report will be wrong – if the BOR_AUD_TRIAL_BALANCE query reconciles, ignore any differences in the report.


 SCHEDULE OF OPERATION OF AGENCY FUND BY FISCAL YEAR (BORRG027) 
	7.5 Report Name:
	SCHEDULE OF OPERATION OF AGENCY FUND BY FISCAL YEAR (BORRG027)

	8.9 Report Name: 
	SCHEDULE OF OPERATION OF AGENCY FUND BY FISCAL YEAR (BORRG027)

	Navigation: 
	7.5 – BOR Year End> Report > Agency Fund

8.9 - BOR Menus, BOR General Ledger > BOR Year End, Year End reports, Agency Funds

	Special Instructions:
	Create a New Run Control ID

	Parameters (Values)
	Run Control ID = AGENCY

For Fiscal Year Ending = 2007

	Expected Results:
	Process will generate a report, listing the Beginning Balance, Additions, Subtractions and Ending Balance for each agency fund.


SURPLUS DEFICIT REPORT BY FISCAL YEAR (BORRG024) 
	7.5 Report Name:
	SURPLUS DEFICIT REPORT BY FISCAL YEAR (BORRG024)

	8.9 Report Name: 
	SURPLUS DEFICIT REPORT BY FISCAL YEAR (BORRG024)

	Navigation:
	7.5 – BOR Interfaces and Reports > GL/Bud Rpt > Surplus/Deficit Report

8.9 - BOR Menus > BOR General Ledger > BOR GL Reports> Surplus/Deficit Report

	Special Instructions:
	Create a New Run Control ID 

	Parameters (Values)
	Run Control ID = SURPLUS

Business Unit = < Institution Specific >
Fiscal Year = 2007

From Accounting Period =1

To Accounting Period = 12

Order By (radio button) = Fund/Class selected
From Fund Code = 10000

To Fund Code = 10000
From Class = 11000

To Class = <max class value less than 20000>
Save

	Expected Results:
	Process will generate a report, displaying detail information, sub-totals by chart field string and totals by department/fund.


	ENVIRONMENT
	DEPARTMENT

	F210
	6600000

	F300
	3900000

	F330
	1011001

	F390
	0110301

	F400
	6010110

	F430
	1044208

	F480
	1004101

	F500
	0101100

	F510
	1341040

	F720
	1101000

	F760
	1625500

	F840
	0102100

	F870
	1009000

	F890
	1044000

	F930
	4100000

	F980
	1511000


BUDGET PROGRESS REPORT BY FUND BY FISCAL YEAR (BORRG042)
	7.5 Report Name:
	BUDGET PROGRESS REPORT BY FUND BY FISCAL YEAR

	8.9 Report Name: 
	BUDGET PROGRESS REPORT BY FUND BY FISCAL YEAR

	Navigation:  
	7.5 – BOR Interfaces & Reports, GL/Bud Rpt, Budget Progress Report

8.9 - BOR Menus, BOR General Ledger, BOR GL Reports, Budget Progress Report


	Special Instructions:
	Run the full detail report. (BORRG042) 
Before running the report, run the following query in 7.5 to identify the correct department id range – make sure to select the same department range for running the reports in each environment:

7.5 Parameters:

select business_unit, substr(deptid,1,5), count(*), sum(posted_total_amt), sum(encumbered_amount) from ps_ledger_budg where budget_period = '2007'and account between '500000' and '700000'group by substr(deptid,1,5), business_unit having sum(encumbered_amount) <> 0 order by 2 desc

For reference purposes only, here are the equivalent 8.9 Parameters:

select business_unit, substr(deptid,1,5), count(*), sum(posted_total_amt)

from ps_ledg_KK_VW3_BOR

where budget_period = '2007'

and account between '500000' and '700000'

group by substr(deptid,1,5), business_unit

having sum(encumbered_amt) <> 0

order by 3 desc)

	Parameters (Values)
	Run Control ID = BUDGET_PROGRESS
Business Unit = < Institution Specific >
Budget Period = 2007

From Accounting Period =1

To Accounting Period = 12

Order By (radio button) = Fund/Class selected
From Fund Code = 10000

To Fund Code = 16000

Get department range from query (above)
From Account = 500000

To Account = %

Select Full Details – ACTUALS checkbox

	Expected Results:
	Process will generate a report that provides detail information regarding budget activity and net available balance.


nVision Reports
	7.5 Report Name:
	nVision Reports

	8.9 Report Name: 
	nVision Reports

	Navigation:
	Reporting Tools, PS/nVision, Report Request, Search,

	Special Instructions:
	Run the following reports for 2007 and 2008; add the year to the end of the report name when saving the report. 


· CASHFLOW= Cashflow 

· SNA= Statement of Net Assets 

· SRECNA= Srecna 

· UNA= Note for UNA

· RNA= Note for RA

· AUXSNA= Statement of Net Assets (AUX)

· AUXSREC= Srecna (AUX)

· NAT= Natural vs. Functional

· CAPASS= Capital Assets Disclosure


NOTE: DO NOT run the AESCHOP reports.



	Parameters (Values)
	For each report:
Report Title = <report specific>
Layout = <report specific>
As of Reporting Date = Specify - 06/30/07

Tree As of Date = Use As of Reporting Date checkbox enabled
Output Options:
· Type = Web

Format = Microsoft Excel Files (*.xls)

	Expected Results:
	See 7.5 to 8.9 Reconciliation Spreadsheet for fields to use in reconciliation for each nVision Report.


Continuous Audit (BORIF01A, BORIF01B) 
	7.5 Report  Name:
	Continuous audit = Travel and per Diem Reports (BORIF01A, BORIF01B and BORIF01C)

	8.9 Report  Name:
	Continuous audit = Travel and per Diem Reports (BORIF01A, BORIF01B and BORIF01C)

	Navigation:
	7.5 – BOR Interfaces and Reports, Interface, Continuous Audit

8.9 - BOR Menus, BOR AP Interfaces, Continuous Audit

	Special Instructions:
	For A Report, don’t have to run 3 times, using different options.  Running one version is sufficient.
Select Option 2 for our validation purposes.

Create a New Run Control ID

	Parameters (Values)
	Add a New Run Control ID = CAUDIT

Business Unit = <institution specific>

Beginning Fiscal Month= 1

Ending Fiscal Month = 12

Fiscal Year = 2007

Employee travel (BORIF01A) Options 

· Check box enabled on Compare Financials to HRMS = Recommend Quarterly
Save
Push Run button

Enable check box for BORIF01A  and BORIF01B (the A &B reports can run together but not the BORIF01C—it must run separately)

OK Push button



	Expected Results:
	Verify that the same errors appear on both versions of the report.


Continuous Audit (BORIF01C) 

	7.5 Report  Name:
	Continuous audit = Travel and per Diem Reports (BORIF01A, BORIF01B and BORIF01C)

	8.9 Report  Name:
	Continuous audit = Travel and per Diem Reports (BORIF01A, BORIF01B and BORIF01C)

	Navigation:
	7.5 – BOR Interfaces and Reports, Interface, Continuous Audit

8.9 - BOR Menus, BOR AP Interfaces, Continuous Audit

	Special Instructions:
	For A Report, don’t have to run 3 times, using different options.  Running one version is sufficient.

Select Option 2 for our validation purposes.

Create a New Run Control ID



	Parameters (Values)
	Add a New Run Control ID = CAUDIT

Business Unit = <institution specific>

Beginning Fiscal Month= 1

Ending Fiscal Month = 12

Fiscal Year = 2007

Employee travel (BORIF01A) Options 

· Check box enabled on Compare Financials to HRMS = Recommend Quarterly

Save

Push Run button

Enable check box for BORIF01A  and BORIF01B (the A &B reports can run together but not the BORIF01C—it must run separately)

OK Push button

Second Run:

When completed, go back and run the BORIF01C report using the same criteria above except the following:

Employee Travel (BORIF01A) Options:

· All boxes should be UN-checked

Travel and Per Diem (BORIF01C) Options:

· Enable the Create Travel and Per Diem File (BORIF01C) check box

Push Run button

Enable check box for BORIF01C (remember, it must run separately)

OK push button

	Expected Results:
	Verify the report totals on both versions of the report.


BOR_TRAVEL_CONT_AUDIT_RECON 
	7.5 Query Name:
	BOR_TRAVEL_CONT_AUDIT_RECON

	8.9 Query Name: 
	BOR_TRAVEL_CONT_AUDIT_RECON

	Navigation:
	Reporting Tools >  Query > Query Viewer

	Special Instructions:
	This report is to be used with the BOR_MILEAGE_CONT_AUDIT_RECON report to balance with the BORIF01C Report

	Parameters (Values)
	Fiscal Year = 2007

Range From Accounting Period = 1

Range To Accounting period = 12

	Expected Results:
	Query will return a summary of travel amounts by account.
Add the amounts returned by the 7.5 BOR_MILEAGE_CONT_AUDIT_RECON query to reconcile amounts between 7.5 and 8.9.


BOR_PERDIEMS_CONT_AUDIT_RECON 
	7.5 Query Name:
	BOR_PERDIEMS_CONT_AUDIT_RECON

	8.9 Query Name: 
	BOR_PERDIEMS_CONT_AUDIT_RECON

	Navigation:
	Reporting Tools >  Query > Query Viewer

	Special Instructions:
	None

	Parameters (Values)
	Fiscal Year = 2007

Range From Accounting Period = 1

Range To Accounting period = 12

	Expected Results:
	Query will return a summary of per diem amounts by account.


BOR_SALARY_CONT_AUDIT_RECON 
	7.5 Query Name:
	BOR_SALARY_CONT_AUDIT_RECON

	8.9 Query Name: 
	BOR_SALARY_CONT_AUDIT_RECON

	Navigation:
	Reporting Tools >  Query > Query Manager

	Special Instructions:
	Update the 8.9 Query before running it:

· Remove the Budget Reference field from the listing of fields selected for output.

DO NOT save your changes!



	Parameters (Values)
	Fiscal Year = 2007

Range From Accounting Period = 1

Range To Accounting Period = 12

	Expected Results:
	Query will return a summary of salary amounts by account (and budget reference).


BOR_MILEAGE_FOR_CONT_AUDIT 
	7.5 Query Name:
	BOR_MILEAGE_FOR_CONT_AUDIT

	8.9 Query Name: 
	NONE exists in 8.9

	Navigation:
	Reporting Tools >  Query > Query Viewer

	Special Instructions:
	Run the query in 7.5 only and use it to balance with the BOR_TRAVEL_CONT_AUDIT_RECON report against the BORIF01C report.
Should not return any results for FY07 or other prior years.

When calendar date is actually in 2008, need to add C report and BOR MILEAGE query results in order to get totals to tie in the C report.



	Parameters (Values)
	Fiscal Year = 2007

Range From Accounting Period = 1

Range To Accounting period = 12

	Expected Results:
	This query does not exist in 8.9 and is only needed for 7.5.  This 7.5 report is to be used with the BOR_TRAVEL_CONT_AUDIT_RECON to balance with the BORIF01C Report



 Purchasing and ePro
BOR_SRECON1_PO_ACCTG 

	7.5 Query Name:
	BOR_SRECON1_PO_ACCTG

	8.9 Query Name: 
	BOR_SRECON1_PO_ACCTG

	Navigation:
	Reporting Tools >  Query > Query Viewer

	Special Instructions:
	When reconciling, the Remaining Amount values will be negative in 7.5 and positive in 8.9.

	Parameters (Values)
	Fund Code = 10000

As of Date = 06/30/07

	Expected Results:
	Query will return a listing of PO’s with open amounts, based on the query parameters.
NOTE:  PO data matches, but amounts still don’t reconcile – need to work on query some more.

	7.5 SQL
	SELECT DISTINCT ':1', B.VENDOR_ID, C.NAME1, TO_CHAR(B.PO_DT,'YYYY-MM-DD'), A.PO_ID, A.FUND_CODE, A.BUDGET_PERIOD, A.ACCOUNT, SUM( A.MONETARY_AMOUNT), B.PO_STATUS,C.SETID,C.VENDOR_ID

  FROM PS_PO_LINE_ACCTG A, PS_PO_HDR B, PS_VENDOR C

  WHERE A.FUND_CODE LIKE :2

     AND A.ACCOUNT = '381100'

     AND A.BUSINESS_UNIT = B.BUSINESS_UNIT

     AND A.PO_ID = B.PO_ID

     AND A.JOURNAL_DATE <= TO_DATE(:3,'YYYY-MM-DD')

     AND A.JOURNAL_DATE >= TO_DATE('1900-01-01','YYYY-MM-DD')

     AND C.VENDOR_ID = B.VENDOR_ID

  GROUP BY  ':4',  B.VENDOR_ID,  C.NAME1,  TO_CHAR(B.PO_DT,'YYYY-MM-DD'),  A.PO_ID,  A.FUND_CODE,  A.BUDGET_PERIOD,  A.ACCOUNT,  B.PO_STATUS,C.SETID,C.VENDOR_ID

  HAVING SUM( A.MONETARY_AMOUNT) <> 0

  ORDER BY 6, 10, 7, 8

	8.9 SQL
	SELECT  ':3', A.VENDOR_ID, C.NAME1, TO_CHAR(B.PO_DT,'YYYY-MM-DD'), B.PO_ID, A.FUND_CODE, A.BUDGET_REF, A.ACCOUNT, SUM( A.MONETARY_AMOUNT), B.PO_STATUS, TO_CHAR(B.PO_DT,'YYYY-MM-DD'),C.SETID,C.VENDOR_ID 
  FROM PS_PO_ACCT_LN_BOR A, PS_PO_HDR_VW_BOR B, PS_VENDOR C 
  WHERE A.BUSINESS_UNIT = :1 
     AND A.BUSINESS_UNIT = B.BUSINESS_UNIT 
     AND A.PO_ID = B.PO_ID 
     AND A.LEDGER = 'DETAIL_EN' 
     AND A.FUND_CODE LIKE :2 
     AND A.ACCOUNT NOT LIKE '381100' 
     AND B.ACCOUNTING_DT <= TO_DATE(:3,'YYYY-MM-DD') 
     AND B.BUSINESS_UNIT = C.SETID 
     AND B.VENDOR_ID = C.VENDOR_ID 
  GROUP BY   ':3',  A.VENDOR_ID,  C.NAME1,  TO_CHAR(B.PO_DT,'YYYY-MM-DD'),  B.PO_ID,  A.FUND_CODE,  A.BUDGET_REF,  A.ACCOUNT,  B.PO_STATUS,C.SETID,C.VENDOR_ID 
  HAVING SUM( A.MONETARY_AMOUNT) <> 0 
  ORDER BY 6, 10, 7, 8


BOR_AUD_PO_OUTSTAND_ENC 
	7.5 Query Name:
	BOR_AUD_PO_OUTSTAND_ENC

	8.9 Query Name: 
	BOR_AUD_PO_OUTSTAND_ENC (not created yet)

	Navigation:
	Reporting Tools >  Query > Query Viewer

	Special Instructions:
	Run for 7.5 only

	Parameters (Values)
	Begin Account: 000000
End Account: 999999

Fiscal Year: 2007

Fund: 10000

	Expected Results:
	Query will return a listing of PO’s with open encumbrance amounts (summary).


BOR_AUD_PO_DETAIL 
	7.5 Query Name:
	BOR_AUD_PO_DETAIL

	8.9 Query Name: 
	BOR_AUD_PO_DETAIL (not created yet)

	Navigation:
	Reporting Tools >  Query > Query Viewer

	Special Instructions:
	Run for 7.5 only

	Parameters (Values)
	Begin Account: 000000
End Account: 999999

Fiscal Year: 2007

Begin Accounting Period: 1

End Accounting Period: 2

Fund Code: 10000

	Expected Results:
	Query will return a listing of PO’s with open encumbrance balance amounts (detail).


PO ARCHIVE QUERIES (New Queries)


	7.5 Report Name:
	Use the 7.5 column in the table shown Special Instructions for the table names to create new queries

	8.9 Report Name:
	Use the 7.5 column in the table shown Special Instructions for the table names to create new queries

	Navigation:
	Reporting Tools >  Query > Query Manager 

	Special Instructions:
	Create new queries for the following tables which count the number of PO ids:

7.5

8.9

PO_HDR

PO_HDR_BOR

PO_LINE

PO_LINE_BOR

PO_LINE_SHIP

PO_LINE_SHP_BOR

PO_LINE_DISTRIB

PO_LINE_DST_BOR

PO_ACCTG_LINE
POS_ACCT_LN_BOR
7.5 SQL Syntax:

Select count (PO_ID) from PS_PO_HDR

 Select count (PO_ID) from PS_PO_LINE

Select count (PO_ID from PS_PO_LINE_SHIP

Select count (PO_ID) from PS_PO_LINE_DISTRIB

Select count (PO_ID) from PS_PO_ACCTG_LINE

8.9 SQL Syntax:

Select count (PO_ID) from PS_PO_HDR_BOR

 Select count (PO_ID) from PS_PO_LINE_BOR

Select count (PO_ID from PS_PO_LINE_SHP_BOR

Select count (PO_ID) from PS_PO_LINE_DST_BOR

Select count (PO_ID) from PS_PO_ACCT_LN_BOR



	Parameters (Values)
	None – see above SQL statements.

	Expected Results:
	All 7.5 Procurement tables will be upgraded to the new BOR created table names.  Row counts should match between the tables in 7.5 and 8.9.


(NA for 7.5) / PO_HDR_VW_BOR (New Queries)
	7.5 Query Name:
	NA - 8.9 Activity Only

	8.9 Query Name:
	PO_HDR_VW_BOR (Table)

	Navigation:
	Reporting Tools >  Query > Query Manager

	Special Instructions:
	Create a new query to validate the status of all converted PO’s. (Since all 7.5 upgraded procurement documents were Closed, PO_STATUS field should be either a ‘C’ or ‘X’.)

Sample SQL statement:

SELECT A.PO_ID, A.PO_STATUS 
  FROM PS_PO_HDR_VW_BOR A 
  WHERE A.PO_STATUS NOT IN ('C', ‘X’)

Or 

SELECT A.PO_ID, A.PO_STATUS 
  FROM PS_PO_HDR_VW_BOR A 
  WHERE A.PO_STATUS <>  ('C')

	Parameters (Values)
	None – see above SQL statements.

	Expected Results:
	Either no rows should show up in the query or only those rows with ‘X’ (Cancel) in the PO_STATUS field.
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